Instruction Manual

Model TT249
Turntable Player

BEFORE USE

1. Choose a safe and horizontal location and avoid placing the unit in direct sunlight or near
any heat source.
Avoid environments subject to vibration, excessive dust, cold or moisture.
Due to the risk of electrical shock, do not open the cabinet. Should a foreign object
accidentally find its way into the interior of the unit, contact your local dealer.

4. Do not attempt to clean the unit with chemical solvents as this might damage the finishing.
A clean, dry cloth is recommended for cleaning.

5. Keep this manual for future reference.
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Lift Lever

Speed switch(33,45,78RPM)

Auto-stop ON/OFF Switch

Tone-arm lock

Ceramic Cartridge

Speakers

Indicator

Power ON/OFF and Volume Control Knob
Turntable Platter

Turntable Platter

45RPM adaptor

USB Port—for vinyl records recording
DCIN Jack

RCA output jack—to connect external speaker system with power amplifier
3.5mm AUX IN port

Getting Started
Fix the dust cover onto the turntable player via the two hinges at the rear of the unit.

Firmly and securely insert the DC plug of the adaptor to the DC IN Jack on the back of the unit.

Plug the adaptor’s AC plugs into a power outlet.

Bluetooth Mode

1.

Turn on the power switch knob. The default mode is Bluetooth mode(when the auto-stop
ON/OFF switch is at ON position). The indicator will become blue color with flashing.

Turn on your Bluetooth function on your mobile phone or tablet PC and then search the
turntable player with its name TT202-W. After pairing and connection, the indicator will
become blue color without flashing, and you can play your music of your mobile phone or
tablet PC on this turntable player.

Turn the VOLUME CONTROL KNOB to adjust the volume. The mobile phone or tablet PC's volume
control also impact the overall volume level. Please adjust that as well if necessary.

Phono Mode

1.
2.

When the auto-stop ON/OFF switch is at ON position,

Place a record on the turntable platter and select the desired speed (33/45/78) according to
the record. NOTE: when playing a 45RPM record, use the included 45RPM adaptor.

Remove the stylus protector. Open the tone-arm lock to release the tone-arm. Push the lift
lever backward to raise the tone-arm and gently move the tone-arm to the desired position
over the record. The turntable will begin to spin when the arm is moved toward the record.
Push the lift lever forward to lower the tone-arm slowly onto the desired position on the record
to begin playing the record. Please note: The record will begin to spin only when the tone-arm
is moved toward the record if the Auto Stop is turned on.

If the Auto Stop Control Switch is turned ON, the record will stop automatically when finished
and the unit will switch to Bluetooth mode. If Auto Stop Control Switch is turned OFF, the
record will NOT stop automatically when finished.



Remark: AUTO STOP function applies to most 33RPM vinyl records. However, for very few
vinyl records, it will stop when it does not come to the end, or it
will not stop when it comes to the end when AUTO STOP is ON.

5. Turn the VOLUME CONTROL KNOB to adjust the volume.
Remark: when the auto-stop is at OFF position, the platter will start to spin when the power is ON.
Switch the auto-stop to ON position for Bluetooth mode.

AUX IN Mode

1. Connect your iPod, MP3 player, mobile phones etc. to the AUX IN port with a 3.5mm-3.5mm
audio cable (not included).

2. You can enjoy the music of iPod, MP3 player, mobile phones etc. at the turntable player.

Turn the VOLUME CONTROL KNOB to adjust the volume. (The iPod, MP3 player, mobile phones’

volume control also impact the overall volume level. Please adjust that as well if necessary.).

RECORD YOUR VINYL TO YOUR WINDOWS PC

1. Setup
Connect the USB cable with your turntable and your computer. No extra driver is required.

2. Audacity Installation

Insert the installation CD. Your computer will auto-run the program. Follow the instructions to
complete installation.

If your computer does not auto run, click on the “Start” menu, select “Run” and choose the CD
located on your computer and run “Setup.exe”

3. Run Audacity Program

Double-click on the Audacity program and the Audacity interface window will be displayed on
your computer screen.
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4. Playback Control Toolbar
Audacity will display a control toolbar for you to edit and manage your recordings.



Button Action

4l  |moves the cursor to the start of the project.

plays your project from the position of the cursor. Use to listen to the audio in your project.
) | pressing the record button will record a new track from your computer's sound input device.
11 | pause playback or recording. Press again to unpause.

stops playback or recording.

)3/ | moves the cursor to the end of the project.

Playing Your Record
Play the record you want to record by following the procedure described in the section
“LISTENING TO A RECORD”

Adjusting Input and Output
Adjust the output and input volume.
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Recording

Select the RECORD button 2. tostart recording while your record is playing.
You will need to position the needle on the record for a few seconds before the track starts, so
that you select the RECORD button at the beginning of your track.

Start playback on the USB turntable. You will see the waveform of the audio on the screen as it
is recording. You will hear the audio coming from the output of your computers soundcard.

No Audio? - go back to the preference menu and make sure you have “Software Playthrough”
selected and the speaker volume up on your computer.



Audacity Preferences

Audio 170 IQuaIityI File Formats | Spectrograms | Directories | Interface | Keyboard | Mouse |

~ Playback
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— Recording
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other tracks while recording new one
ware Playthrough (Play new track while recording it}

Cancel | ok |

n
Press Stop
SAVE YOUR FILE NOW by clicking on “File” followed by “Save Project”
Select the destination and file name for the project and click “Save”

Once finished recording, your screen should display your recording as below.
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Editing your Recording

Audio Levels
Select your entire recording by selecting “Edit,” then “Select...” then click “All”
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Select the “Effect” menu and choose the desired effect. There are various types of effects which
are described further on Audacity’s website.
Selecting “Normalize” should be used to have Audacity auto-correct volume on the recording.
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Noise Reduction
Drag your cursor over a portion of the audio track which contains unwanted noise. We
recommend using the beginning or end of  a track where there is no music and only noise.
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- Select “Effect” and then “Noise Removal” from the drop down menu to bring up the “Noise
Removal Window”

|

Moise Remowval m
Moige Remaoval by Dominic Mazzoni
Step 1

Select a few seconds of just noise
s0 Audacity knows what to fitter out, then
click Get Moise Profile:

Get Moige Profile |

—Step 2

Select all of the audio you want fittered,
choose how much noise you want fitered out,
and then click Remove Moise.

Less More

Remove Moige |
Close |




- Click“Get Noise Profile” and the window will close automatically.

- Select the entire track of audio you wish to remove noise from.
- Adjust the amount of audio that you would like to filter by moving the slider in the “Noise
Removal” window. We recommend using the minimum noise removal for optimum sound.

Note: you can preview the audio before removing the noise by clicking on‘Preview’.
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Moise Removal

Moige Remaoval by Dominic Mazzoni

Step 1

Select a few seconds of just noise
s0 Audacity knows what to fitter out, then
click Get Moise Profile:

Get Moige Profile |

Step 2

Select all of the audio you want fittered,
choose how much noise you want fitered out,
and then click Remove Moise.

Less More

Remove Moige |

Close

- Click on’Remove Noise'.

The Editing Toolbar
Button
ﬂThe Cut button
@Tha Copy button
@ The Paste button
ﬂ The Trim button
M The Silence button
ﬂTha Undo button
ﬂThs Redo button
ﬂTha Zoom In button
ﬂTha Zoom Out button
&Ths Fit Selection button

42| The Fit Project button

The Tools Toolbar

Action

removes selected audio data and places it on the clipboard.

copies the selected audio data to the clipboard without removing it from the track.

pastes whatever is in the clipboard into the track at the position of the selection cursor.
deletes all of the track except the current selection.

replaces the current selection with silence instead of removing it completely.

undo the last editing operation performed.

redo any editing operations that were just undone.

zooms in on displayed tracks displaying less time and giving a more detailed view of the track.
zooms out displaying more time and a less detailed view of tracks.

fits selected audio into the width of the sereen to show the selection in more detail.

shows entire project in one screen.



o.

Button Action

ﬂ The Selection Tool |use to select sections of an audio track to work on.
ﬁTha Envelope Tool this tool allows you to control how tracks fade in and out.
ﬂ The Draw Tool allows you to draw on the waveforms of individual tracks.
ﬂ The Zoom Toal zooms in or out of a specific part of the audio.

«» | The Timeshift Tool |allows you to change the positioning of tracks relative to one another in time.

Before editing, you must make a selection of the recording you would like to cut or copy. This

will trim any music from the previous track, or any silence on the record between tracks.

To select the part you wish to cut, copy or paste, use the selection tool. If it is not activated,
do so by clicking on it in the toolbar.

Press and hold the left mouse button while you drag the mouse to a marked area.

This area is darker than the surrounding area of the clip. Note, even though you can mark
an area larger than or extending beyond the actual audio clip in the track, the operations
will only work on the actual clip. Playback however will work outside the clip.

Press the space bar to listen to the audio in the marked area.
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To extend or contract your selection, hold down the SHIFT button and click on the area you
wish your selection to extend or contract to.

If you click at a spot that is on the right hand side from the middle of the current selection,
you will set the right hand boundary of your new selection.

Now you must cut your selection. Select “Cut” from the “Edit” menu.

Before the Cut After the Cut

Create a new file and paste your cut into the new file.

Exporting to MP3



To export your recording to mp3 format, select “Export As” from the “File” menu. You will need
to choose which format to export to. Choose “mp3” as your file extension. When exporting, do
not choose your Desktop as the destination folder. You can only choose “My Documents” folder.
After export, you can move the files as desired.

For additional software information, please refer http://audacity.sourceforge.net for
detailed operating instructions.

TIPS FOR BETTER TURNTABLE PERFORMANCE

When opening or closing the turntable cover, handle it gently, gripping it either at the centre
or at each side.

Do not touch the needle tip with your fingers; avoid bumping the needle against the turntable
platter or record edge.

Gently wipe the dust cover and turntable housing with a soft dry cloth. Never apply harsh
chemicals or solvents to any part of the turntable system.

FCC Statement

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with
the instructions, may cause harmful interference to radio communications. However, there is
no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by
one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

* Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

* Consult the dealer or an experienced radio/TV technician for help.

Caution: Any changes or modifications to this device not explicitly approved by manufacturer
could void your authority to operate this equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

RF Exposure Information

The device has been evaluated to meet general RF exposure requirement. The device can be
used in portable exposure condition without restriction.


http://audacity.sourceforge.net/

